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Programa   ImageJImageJ  

O  Programa  ImageJ foi  criado  para  manipular  imagens  de  qualquer
formato ou padrão. E para nossa sorte, é um dos poucos que manipula o
padrão DICOM utilizado na medicina, em especial na radiologia digital.
Muito usado por pesquisadores, além de manipular imagens, outra função
muito  importante do programa é obter  informações e estatísticas,  como
medir áreas e distâncias, saber as cores/tons presentes, além de aplicar
filtros necessários e alterar a apresentação das imagens para pesquisas
científicas. 

Este programa é um aplicativo desenvolvido gratuitamente na linguagem Java. Por isso,
na maioria dos casos não precisa ser “instalado” no computador (e nem requer senha de
administrador  para  usá-lo).  Pode  ser  utilizado  em  qualquer  sistema  operacional
(Windows, Linux, OS X). Para baixá-lo acesse https://imagej.nih.gov/ij/download.html. A
versão atual é 1.8 (Plataform Independent).

Outra versão com mais algumas funções é conhecida como Fiji (*). Você pode encontrá-
la em https://imagej.net/Fiji/Downloads. O Fiji, atualmente na versão 1.53c (a contagem
é diferente) é totalmente compatível  com o  ImageJ.  Visualmente o  Fiji é idêntico ao
ImageJ, apenas nas abas Analyze e Plugins é que poderemos notar a diferença com a
presença de mais funções.

Outros aplicativos ou plugins que foram desenvolvidos com base no ImageJ são: 
• Bio7 – aplicativo para modelamento ecológico e análise estatística, inclui o ImageJ;
• Icy – análise de imagens biológicas; 
• BoneJ – plugin para FIJI de análise de ossos.

Outro função importante é que você pode facilmente criar uma Macro, Plugin ou Função
e adaptar o  ImageJ para funcionar como você quiser ou precisa. Ou seja, o ImageJ é
programável,  você  pode  fazer  suas  próprias  manipulações  de  imagem  de  forma
automática, sem precisar ficar repetindo comando por comando inúmeras vezes (macro).
E também criar um algoritmo (sequencia de instruções), que chamamos de função, para
extrair informações ou mesmo alterar a imagem, como medir a área de um tumor ou
destacá-lo  (trocar  a  cor)  quando  ao  aplicativo  encontrar  um  na  imagem.  Se  esse
algoritmo for interessante e servir para outros usuários você pode incluí-lo no pacote
ImageJ, no formato plugin, para que outros usuários também possam usar. 

As imagens e textos descritos neste manual foram baseados na versão 1.53h do aplicativo.

* FIJI é abreviatura para Fiji is just ImageJ, ou traduzindo, FIJI é apenas ImageJ.

https://imagej.nih.gov/ij/download.html
https://imagej.net/Fiji/Downloads


1. Instalando                                                                                                       

Após baixá-lo, normalmente em formato compactado, você deve escolher um diretório
para descompactar todos os arquivos. Para Windows, a dica é usar seu diretório pessoal
(C:\usuário\seu nome) e NÃO o C:\arquivos de programas. 
Procure o arquivo ij.jar, no diretório onde foi descompactado e selecione-o para rodar. 

Ao abrir,  você verá  que ele  tem uma interface bem simples  e até mesmo pequena.
Apenas uma barra de ferramentas.

Figura 1: Janela inicial do programa ImageJ. (versão 1.53h)

Ele permite a inclusão de muitos Plugins (funções desenvolvidas que são acrescidas ao
programa principal). Por isso, dependendo da versão que você baixar, isso pode alterar
um pouco a sua estrutura ou a disposição dos ícones. Outro ponto importante é que ele
permite que você crie macros e algoritmos, permitindo a você desenvolver verdadeiros
programas de manipulação de imagens, inclusive com interação do usuário. Isso é outra
vantagem do ImageJ em relação a alguns programas comerciais.

2. Janela Principal                                                                                             

Todo o funcionamento do ImageJ está baseado na Janela Principal que vamos chamar
de Barra Principal a partir de agora e é mostrada abaixo.

Figura 2: Barra Principal do ImageJ. (versão 1.53h)

Nessa barra principal podemos ver os seguintes menus/textos: (versão 1.53h)

File → New, Open, Open Next, Open Samples, Open Recent, Import, Close, Close All, Save, Save As,
Revert, Page Setup, Print, Quit.
Edit →  Undo, Cut, Copy, Copy to System, Past, Past Control, Clear, Clear Outside, Fill,  Draw, Invert,
Selection, Options.
Image →  Type, Adjust, Show Info, Properties, Color, Stacks, Hyper-stacks, Crop, Duplicate, Rename,
Scale, Transform, Zoom, Overlay, Lookup Table.
Process → Smooth, Sharpen, Find Edges, Find Maxima, Enhance Contrast, Noise, Shadows, Binary,
Math, FFT, Filters, Batch, Image Calculator, Subtract Background, Repeat Command.
Analyze  → Measure,  Analyze  Particles,  Summarize,  Distribution,  Label,  Clear  Results,  Set
Measurements, Set Scale, Calibrate, Histogram, Plot Profile, Surface Plot, Gels, Tools
Plugins → Macros, Shortcuts, Utilities, New, Compile and Run, Install.
Window → Show All, Main Window, Put Behind, Cascade, Tile



Help → ImageJ Website, ImageJ News, Documentation, Instalation, Mailing List, Dev. Resources, 
Plugins, Macros, Macro Functions, Examples, Update ImageJ, Refresh Menus, About Plugins, About 
ImageJ  

E também logo abaixo vê-se os ícones com as seguintes funções: (em alguns deles, o 
botão direito do mouse abre um submenu e o duplo clique configura a ferramenta)

• Desenhar retângulo, elipse, polígono, mão livre, reta, ângulo e múltiplos pontos.
• Varinha
• Inserção de texto
• Zoom
• Deslocamento
• Captura de cor
• (DEV) Desenvolvimento
• (Stk) Pilha
• Pintura
• Preenchimento
• Seta
• >> → permite inserir mais ícones na barra, retornar a configuração original, etc.

Nota: De acordo com a versão (1.46/1.52/1.53/1.80) ou o aplicativo utilizado (Fiji, p.ex.),
podem haver pequenas alterações nas abas, menus e funções descritas acima.



3. COMO CARREGAR UMA IMAGEM                                                               

Para o uso da Radiologia, a vantagem do ImageJ é que ele permite a manipulação de
imagens no Padrão DICOM, que é o  formato  oficial  das  imagens médicas.  Também
permite salvar as imagens DICOM em outro formato, como JPG, PNG, GIF, etc.

Para carregar/visualizar uma imagem, você pode fazer de 2 maneiras:
• Na barra principal, usar o Comando FILE → OPEN; ou aperte simultaneamente

CTRL + O;
• Arrastar a  imagem/arquivo  até  em cima da barra do programa.  Aparecerá  as

palavras  Drag  and  DROP  no  canto  esquerdo  da  janela,  mostrando  que  o
programa entendeu que você quer abrir aquela imagem. Solte o botão do mouse e
a imagem será aberta;

• É possível selecionar várias imagens ao mesmo tempo (com tecla SHIFT) e abrir
tudo de uma única vez, seja arrastando, seja selecionando na lista do diretório.

Quando a imagem é aberta, a mesma aparece em uma
nova janela, independente/fora da janela do programa.
Isso pode parecer desconfortável, pois a mesma pode
ficar  escondida por  outro  programa que esteja  ativo,
mas  é  muito  útil  para  se  comparar  duas  ou  mais
imagens ao mesmo tempo, pois as janelas podem ser
posicionadas lado a lado. 
Este  é  uma  premissa  básica  do  ImageJ:  todas as
respostas/informações/imagens/resultados  são
apresentados em novas janelas (figura 3). Isso deixa a
tela  poluída,  mas permite mais facilmente colocar as
informações/imagens lado a lado.
Após carregar uma imagem, se você quiser duplicá-la,
use as teclas CTRL+SHIFT+D e escolha o nome para a
nova imagem.

Figura 3: Janela com uma imagem:
informações no cabeçalho - tamanho, matriz de pixels,

profundidade de bits e tamanho do arquivo.

4. OBTENDO   INFORMAÇÕES                                                                           

Outra vantagem do  ImageJ é que facilmente se pode
obter  informações  do  arquivo  de  imagem,  como
data/hora, número de bits, tamanho da matriz de pixels,
inclusive máquina/modelo que tirou a foto, condições de
zoom  ou  iluminação,  local  (GPS),  etc.  No  caso  de
arquivos  DICOM,  se  obtêm  todas  as  informações
(tags/metadados) do paciente (figura 4), modalidade e
equipamento utilizado, do setor, protocolo, etc.

Uma  vez  aberta  a  imagem,  clique  na  imagem (para
selecioná-la) e aperte simultaneamente CTRL + I. Abrirá
uma nova janela com todas as informações da imagem.
Como trabalhamos com o padrão DICOM, podemos ver
todas as TAG’s DICOM, que foram incluídas no arquivo.
Figura 4: Janela apresentando as informações da imagem.



5. HISTOGRAMA                                                                                                

Histograma é uma função que conta o número de ocorrências de uma determinada
categoria. No caso das imagens radiográficas, o histograma conta o número de  pixels
que contém aquele tom de cinza. Ou seja,  o histograma é uma lista ou tabela (mas
normalmente apresentado na forma de gráfico) que informa, por exemplo, que existem

100 pixels com o tom   0, 
220 pixels com o tom   8, 
  35 pixels com o tom 12, 

  …  e assim por diante. 

Ele conta quantas vezes aparece o tom de cinza na imagem, mas, importante notar, não
informa sua posição na imagem, nem a qual estrutura anatômica pertence.

Figura 5: Exemplo de histograma com tons de cinza e números de ocorrências (pixels)
daquele tom.

Para exibir o histograma de uma imagem no  ImageJ, escolha a janela da imagem, e
aperte simultaneamente CTRL + H. Abrirá uma nova janela com o gráfico do Histograma.
Se quiser procurar no menu, a opção está em Analyze → Histogram.

           
(a) (b)

Figura 6: (a) Histograma da imagem radiográfica. (b) Histograma Live ativado: ao se
criar uma área na imagem, é apresentado apenas o histograma daquela área delimitada.



Verifique como o histograma apresenta a quantidade de preto, branco ou tom de cinza
presente na imagem. Veja que ele mostra também o total de pixeis (Count), os valores
máximo (Max) e mínimo (Min) do histograma, a média de todos os tons (Mean), a moda
(Mode) da contagem e o desvio padrão (StdDev). 

Bins são o número de segmentos que foi divido a escala (256) e Bin width é a largura de
cada  Bin (arredondando =  16).  Isso  significa  que  o  Bin 1  (1o segmento)  acumula  a
contagem dos tons de cinza de 0 a 15, Bin 2 (2o segmento) acumula os pixels com tons
de 16 a 31, Bin 3 (3o segmento) vai de 32 a 47, e assim até o Bin 256 (256o segmento)
que  acumula  os  pixels com tons  de  cinza  de  4080  a  4095,  que  é  o  valor  máximo
apresentado. Seria como você contasse as pessoas que tem de 10 a 19 anos de idade,
de  20  a  29  anos,  e  assim  por  diante,  juntando-as  em  grupos  por  faixa  de  idade.
Passando o cursor por cima do gráfico é possível ler o tom de cinza (value) e o número
de pixeis (count) que ele possui naquele Bin. 

Na opção automática, o  ImageJ apresenta o histograma de toda a imagem (todos os
pixels). Mas ele permite que na janela de Histograma você peça a opção LIVE. Com ela,
é possível selecionar com o cursor uma região da imagem (retangular) e verificar como é
o histograma (distribuição dos tons de cinza) apenas naquela região.

Após abrir uma imagem e ver o histograma completo,
clique no botão Live, e faça retângulos sobre a imagem
e verifique como cada região  apresenta  seu  próprio
histograma.

Veja como os valores máximo e mínimo se alteram,
média  e  desvio  padrão.  Todos  esses  valores  são
referentes apenas aquela área que você selecionou.
Procure  comparar  os  histogramas  locais  com  o
histograma total. Observe a imagem (mais clara, mais
escura, com muito branco ou muito preto) e veja como
a sua percepção visual é representada no histograma.

Figura  7:  Histograma  de  uma  região  utilizando  a  função
LIVE: note que os valores máximo e mínimo se alteram, bem como a média e outros parâmetros.

6. AJUSTE DE BITS                                                                                           

A imagem  que  apresentamos  estava  codificada  em  16  bits  (65 536  tons  de  cinza
diferentes). Porém só se utilizam normalmente 12 bits em imagens radiográficas (216 =
4 096 tons), que é o padrão DICOM. Por isso o valor máximo do histograma é 4 095
(lembre-se  que se  começa  a  contar  em 0  =  preto).  Porém,  muitas  vezes  é  comum
baixarmos a resolução de cores para 256 níveis, pois o olho humano não percebe todos
os 4 mil tons e a manipulação da imagem fica facilitada. 

Escolha  novamente  a  janela  da  imagem.  Na  barra
principal do  ImageJ escolha a opção IMAGE →  Type
→ 8-Bit. Para fins de análise matemática das imagens,
trabalhar com imagens de 8 bits (0 a 255 tons de cinza)
é  mais  conveniente  e  no geral,  não há perda visual
perceptível por causa disso.

Figura 8: Como acessar a função de ajuste da resolução.



Escolha a janela da imagem e chame a função Histograma novamente. Compare os
valores  entre  os  dois  histogramas.  Veja  os  valores  de  média  e  máximo  como  se
alteraram numericamente, mas o gráfico se mantém com a mesma forma. A largura dos
Bins também se altera.

7. AJUSTE DE HISTOGRAMAS                                                                         

Uma das ferramentas para melhorar a qualidade de uma imagem, ou seja, melhorar seu
contraste e a melhor  identificação das anatomias e patologias,  é a  equalização e a
normalização do histograma.

Equalização: Consiste em uma  transformação não-linear que considera a distribuição
acumulativa da imagem original,  para gerar uma imagem resultante, cujo histograma
será aproximadamente uniforme (com menos picos ou concentrações). Segue o princípio
que o contraste de uma imagem seria otimizado se todos os 256 possíveis níveis  (ou
4096) de  intensidade/cinza  fossem  igualmente  utilizados,  ou  seja,  todas  as  barras
verticais  que  compõem  o  histograma  fossem  da  mesma  altura.  Na  prática  essa
uniformização/distribuição é difícil  de ocorrer, mas a ferramenta cumpre seu papel na
maioria  dos  casos,  melhorando  o  contraste  da  imagem  e  muitas  vezes  revelando
detalhes escondidos.
A equação de equalização é a seguinte:

P(n) = arredonda ( L−1total
∑
c=0

n

H (c))
Descrevendo: O novo valor do pixel  P(n) é o valor arredondado da soma de todos os
pixeis H(c) que tem os valores do nível de cinza 0 até aquele valor n, multiplicado pela
distribuição entre os níveis de cinza (L-1) e o total de pixel da imagem.

Por exemplo: Seja uma imagem de 64 x 64 pixeis com 8 níveis de cinza (0 a 7) e
variação de altura no histograma de 81 a 1023.

Figura 9: Tabela e gráfico do histograma original.

Figura 10: Cálculo do novo histograma, tabela resultante e gráfico do histograma alterado.
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Podemos notar que o tom 0 passou a ser o tom 1, o tom 1 passa a ser o tom 3, tom 2
para 5, 3 → 6, 4 → 6, 5 → 7, 6 → 7, 7 → 7. Houve portanto uma alteração no número de
tons e na quantidade de pixeis com esses tons. E o novo histograma possui todas as
barras mais próxima entre si na altura: variação de 448 a 1023 (antes era 81 a 1023).

Normalização/Expansão: quando um histograma não ocupa toda a faixa possível (de 0
a 255) de tons de cinza, p.ex., de 23 a 198, então se pode expandir o histograma de
forma que toda a faixa seja ocupada. Ou seja, se a imagem apresenta só tons escuros,
de 10 a 90 por exemplo, podemos fazer que a escala passe a ser de 0 a 255. Assim, o
contraste é reduzido, mas detalhes que estavam “escondidos” aos nossos olhos podem
aparecer com a distribuição dos pixels em mais níveis de cinza.
A equação de equalização é a seguinte:

P(n) = arredonda ( n−MIN
MAX−MIN

(L−1))
Descrevendo: O novo valor do pixel P(n) é o valor arredondado da proporção que este
tom de cinza n tem em relação a faixa atual de níveis de cinza, multiplicado pela faixa
total dos níveis de cinza (L-1).
Obs.: Se a faixa total já for utilizada – há pixels contados no tom 0 e no tom 255 - não há o que expandir.

Por exemplo: Seja uma imagem de 64 x 64 pixeis com 8 níveis de cinza (0 a 7), mas
que só tem pixels entre 1 e 4.

Figura 11: Tabela e gráfico do histograma original.

Figura 12: Cálculo do novo histograma, tabela e gráfico do histograma alterado.

Podemos notar que os pixels que estavam no tom 1 passaram para o tom 0, os pixels do
tom 2 ficaram coincidentemente no mesmo lugar, os pixels do tom 3 foram para o tom 5,
e  do  tom  4  para  7.  Houve  portanto  uma  distribuição  dos  pixels por  todos  os  tons
disponíveis. E o novo histograma ocupa toda a faixa de tons, de 0 a 7. Isto faz com que
os 4 tons que são consecutivos, e por isso difícil de ser percebido pelos nossos olhos,
fiquem mais afastados e por isso mais fácil de serem visualizados.

No programa ImageJ, estas duas ferramentas se encontram na mesma função/menu na
barra principal → PROCESS. 
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Vamos aplicar a equalização e comparar com a imagem
original.  Escolha  a  janela  da  imagem.  Aperte
simultaneamente  CTRL  +  SHIFT  +  D,  para  duplicar  a
imagem.  De  um  novo  nome  a  imagem:  p.ex.
“Equalizada1”.
Escolha  a  janela  da  imagem  “Equalizada1”.  Na  janela
ImageJ escolha a opção PROCESS → Enhance Contrast.

Figura 13: Como acessar a função de ajuste do Histograma.

Na janela de melhoria de contraste aparecem algumas opções:
Saturated Pixels (pixels saturados): Determina o número de pixels
na  imagem  que  podem  ficar  saturados.  Aumentar  esse  valor
aumentará o contraste. Esse valor deve ser maior que zero para
impedir  que  alguns  pixels  periféricos  façam  com  que  o
alongamento do histograma não funcione como pretendido.

Figura 14: Janela de melhoria do contraste.

Os parâmetros Saturated Pixels e Normalize são ignorados quando Equalize Histogram
é escolhido.

Faça  testes  alterando  as  opções  e  comparando  as  novas  imagens  com  a  imagem
original.  Se precisar,  crie  várias cópias (“Equalizada2”,  “Normalizada3”)  e  aplique em
cada  uma  delas  uma  opção  de  ajuste  do  histograma.  Faça  alterações  nos  valores
percentuais e escolha Normalize. 

Após aplicar  os  ajustes de histograma,  aperte  simultaneamente  CTRL + H em cada
imagem selecionada e compare também os histogramas. 

8. REGIÃO DE INTERESSE                                                                               

Região de Interesse  (ROI) é o nome dado a uma região – retangular ou elíptica, ou
ainda  de  forma  livre,  da  qual  se  retira  muitas  informações  importantes  a  cerca  da
imagem  naquela  região.  Essa  região  serve  para  se  saber  se  um  artefato  é  uma
patologia, qual sua provável densidade, e se a região é homogênea ou heterogênea.
Também permite, a partir do formato do ROI, ou seja, do desenho que você fez, saber a
área deste ROI, e com isso, a área de um tumor, por exemplo.

Escolha a janela da imagem que quer trabalhar.  Na  barra principal,  escolha a opção
ANALYSE  →  Tools →  ROI  Manager.  Será  aberto  uma  nova  janela,  chamada  ROI
MANAGER, com mais opções sobre o uso e manipulação do ROI. Acompanhe na figura
15 os passos e menus que se abrem.



       
Figura 15: Como abrir o Gerenciador de ROI.

Desenhe um círculo na imagem e clique em ADD. Aparecerá
na lista um código. Se quiser trocar o nome, clique em cima
desse  código  (para  ficar  selecionado  em  azul)  e  escolha
RENAME e troque para, por ex., “Coração”.

Para alterar o formato da ROI, vá
na janela ROI Manager escolha a
opção More → Specify
Na janela que se abre, é possível
definir a largura (Width) e altura
(Height) da área, bem como sua
posição (X,Y) na imagem.

Figura 16: Imagem com uma
ROI circular e a 

janela ROI Manager.

Com a opção Oval, você alterna o formato entre
quadrado  e  retângulo  e  uma  elipse  e
circunferência. 

A opção  Constrain,  garante  que  a  área  será
sempre  um quadrado  ou  círculo  (depende  da
opção Oval).

A opção  Centered, indica que as coordenadas
X,Y se  referem ao  centro  da  área  (e  não  ao
canto superior esquerdo).

Figura 17: Janela com as 
opções de ajuste da ROI.

A opção  Scaled units,  indica se os valores anteriores estão em  pixels ou milímetros
(mm).

Outro recurso interessante é o que permite você salvar a(s) ROI(s) para utilizá-la(s) em
outras imagens ou outro dia. Isso garante que: 



1) você não precisará digitar  e ajustar tudo de novo, outra vez que utilizar o
programa;
2) terá a certeza que o mesmo conjunto de ROI’s será usado em outra imagem,
nos mesmos lugares e com mesmo tamanho, garantido a comparação fidedigna
entre várias imagens.

Para realizar esse processo, você tem que escolher uma ou mais
ROI’s da listagem e depois More → Save … De um nome ao arquivo
e ... SALVAR.

Para recuperar e utilizar uma ROI ou conjunto pré-gravado, escolha
More → Open … Escolha o arquivo e ... ABRIR.
Se for salvo várias ROI’s ao mesmo tempo, um único arquivo  .zip
será salvo.

O  objetivo  de  se  usar  o  ROI  é  obter  informações  de  um  local
específico da anatomia ou da imagem. Então, clique em MEASURE
e veja  a  janela  com os  resultados  de  média,  máximo,  mínimo  e
tamanho da área.  Se você estiver  visualizando apenas uma ROI,
somente  um  conjunto  de  medidas  serão  apresentadas.  Se  você
optar  por  SHOW  ALL,  as  medidas  de  todos  as  ROI’s  serão
fornecidas. Para saber quais ROI serão medidos, a lista de ROI deve
estar selecionada (faixa azul sobre os códigos/nomes).

Figura 18: Janela com a 
opção de Abrir e Salvar.

Figura 19: Janela com os resultados das Medidas de um ROI.

O ImageJ aproveita a mesma janela Results para apresentar os resultados de diferentes
medidas que você faça. Assim, se você tiver uma única ROI e pedir para medir três
vezes, aparecerão na janela três conjuntos de medidas (numeradas 1, 2, 3). Se você
achar confuso, podes usar a opção Results → Clear para limpar a janela e começar de
novo as medidas.

Às vezes o ImageJ não apresenta o desvio padrão em suas
medidas.  Nesta  mesma  janela  de  resultados,  escolha
RESULTS →  Set  Measurements. E  clique  em  Standard
deviation e  depois  OK.  Clique  novamente  na  opção
MEASURE e veja o novo resultado. 

Figura 20: Janela com as opções de medidas do ROI.



Faça  várias  áreas  de  ROI  na  imagem  e  clique  em  SHOW  ALL para  ver  todas  as
informações das ROI ao mesmo tempo. 
Utilizando o histograma e a ROI, verifique como muda cada região da imagem quando
você Equaliza ou Expande o histograma.

9. AJUSTANDO A JANELA DE TONS       

Janelamento é o nome dado para a conversão entre os valores medidos para tons de
cinza em imagens de tomografia computadorizada e ressonância magnética. É utilizada
para tornar mais eficiente a reprodução e visualização da imagem nos monitores uma
vez que  o  próprio  olho  humano não  consegue distinguir  mais  dos  que uns 30  tons
diferentes  de  uma  mesma  cor.  Esse  conceito  também  foi  levado  para  imagens  e
fotografias comuns.

Janelamento consiste em transformar os valores que você tem na imagem (que podem
ser tons/cores ou mesmo medidas da TC e RM) em uma nova escala, onde apenas parte
dos valores/cores/tons são mostradas na escala de 0-255 ou 0-4096, por exemplo. 
A transformação  se  dá  numa  faixa  de  tons/cores/valores  que  se  quer  destacar  e
visualizar, suprimindo os demais valores que estão na extremidade inferior e superior.
Vejamos  o  exemplo  da  tomografia  computadorizada,  onde  os  valores  medidos  de
atenuação pelos detectores, chamados de Unidades de Hounsfield, são convertidos em
tons de cinza para exibição no monitor.

Figura 21: Conversão de unidades de hounsfield em escala de cinza pelo método de janelamento.

Os valores da TC podem variar de -1 000 a 3095. Contudo não podemos visualizar ou
distinguir  todos  esses  4096  tons  na  tela  do  monitor,  e  muitas  anatomias  serão
visualizadas como sendo homogêneas  no tom,  apesar  de  terem várias  unidades de
Hounsfield diferentes. Com o janelamento, pode-se então escolher apenas uma faixa de
valores que será visualizada com detalhes, enquanto que os valores fora dessa faixa
serão apresentados pretos (extremidade inferior) ou brancos (extremidade superior).

E  para ocorrer essa transformação de escala, são utilizadas duas variáveis:  centro ou
nível,  e  largura.  Largura  da  janela  é  a  quantidade  de  valores  originais  que  serão
convertidos nos 256 ou 4096 tons ou cores. Centro ou nível é o valor médio/central do
valor original que receberá será o meio dessa nova escala.
No exemplo acima, temos no primeiro janelamento → largura 1600 (900 - -500) e centro
em 200 (o que dá 700 unidades de Hounsfield para cada lado). No segundo janelamento
→ largura 400 (1200 - 800) e centro em 1000 (resulta em 200 unidades de Hounsfield
para cada lado).

128

200

255

900

0

- 500

255

3095

0

- 1000

Escala de cinza

Unidades Hounsfield

128

1000

255

1200

0

800

255

3095

0

- 1000

Escala de cinza

Unidades Hounsfield



Escolha a janela da imagem. Na barra principal,
escolha  a  opção  IMAGE  →  Adjust  →
Window/Level. (figura 22)

Uma  nova  janela  com  os
controles para ajuste do centro
(Level)  e  largura  (Window)  da
janela  aparecerão  (figura  23),
bem  como  um  pequeno
histograma  da  imagem  para
facilitar o entendimento do que
se está ajustando. A reta indica
como é feita a conversão.

Figura 22: Menu de acesso a função de janelamento.
Figura 23: Janela com os controles de janelamento.

Figura 24: Ajustando a janela (reta) para destaque da
região central do histograma.

10.COMO MEDIR ÁREAS E DISTÂNCIAS                                                         

Para medir áreas, distâncias e ângulos, primeiro selecione a ferramenta específica na
barra  principal  (quadrado,  circulo,  distância,  ângulo...).  Na  figura  25,  canto  superior
esquerdo acima da palavra  ferramentas.  Depois faça o desenho do ROI na imagem
(exemplo  em  amarelo  na
região  dental).  Por  fim,
escolha  Analyze → Measure
ou  aperte  simultaneamente
CTRL + M. Uma janela com
os  resultados  aparecerá.
Dependendo  da  forma
desenhada ou ferramenta, a
tabela  apresentará  o
comprimento  (Length),
ângulo (Angle), e área, além
dos valores médios, máximo
e  mínimo  dos  pixels da
geometria. 

Figura 25: Área desenhada a mão livre (em amarelo) e janela com as medidas.

ferramentas


